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Using the documentation

Thank you for buying a Brother machine! Reading the documentation will help you make the most of your
machine.

Symbols and conventions used in the documentation

The following symbols and conventions are used throughout the documentation.

IMPORTANT IMPORTANT indicates a potentially hazardous situation which, if not avoided, may
result in damage to property or loss of product functionality.

NOTE Notes tell you how you should respond to a situation that may arise or give tips
about how the operation works with other features.

Bold Bold style identifies keys on the machine or computer screen.
Italics Italicized style emphasizes an important point or refers you to a related topic.
NOTE

» For DSmobile 720D users: this guide uses DSmobile 620 screen images, unless otherwise indicated.

* If you are using a tablet running Windows®, you can make your selections either by tapping the screen or
by clicking with your mouse.



Trademarks

The Brother logo, Brother and DSmobile are registered trademarks of Brother Industries, Ltd.

Apple, Macintosh, and Mac OS are trademarks of Apple Inc., registered in the United States and other
countries.

Windows and Windows Vista are either registered trademarks or trademarks of Microsoft Corporation in the
United States and / or other countries.

Nuance, the Nuance logo and PaperPort are trademarks or registered trademarks of Nuance
Communications, Inc. or its affiliates in the United States and / or other countries.

Any trade names and product names of companies appearing on Brother products, related
documents and any other materials are all trademarks or registered trademarks of those respective
companies.
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General Information

Scanner overview

Front

1 Top cover
2 Start button

(For Windows®)
Press to start scanning while using Button Manager V2.
For more information, see Using Button Manager V2 (for Windows®) on page 31.

3 Document guide
4 Feeder slot
5 Left edge



General Information

Rear

DS-620 DS-720D

1 Micro USB port
2 Paper ejection slot

LED indications

LED indication Machine Status
No light The machine is not connected to your computer.
Green light The machine is ready to scan.
Blinking green The machine is scanning a document.
A
[,
Rapidly blinking red An error occurred. The top cover is open, or a document is jammed.
—|—
T
R




Installing the Scanner Driver and
Scanning Software

®

For Windows = users

NOTE
» Make sure that your computer is ON and you are logged on with Administrator rights.
* DO NOT connect the Micro USB Cable yet.

* If your computer does not have a DVD-ROM drive, the supplied DVD-ROM does not contain drivers for
your operating system, or you want to download manuals and utilities, visit your model page at

support.brother.com

@ insert the DVD-ROM.

9 When the Setup screen appears, click Install Scanner Driver and follow the on-screen instructions.

DSmobile 620 brother

Top Menu l

Install Scanner Driver
Driver & Software Package

b User's Guides

H Additional Applications
OL Brother Support
‘ jzl On-Line Registration

+{J Exit

(C) 2001-2013 Brother Industries, Ltd. All rights reserved

NOTE
+ If the Brother screen does not appear automatically, go to My Computer (Computer), double-click the

CD-ROM icon, and then double-click AutoRun.exe.

* When you install the scanner driver, DSmobileCapture (a scanning application) will be installed at the
same time. For more information on using DSmobileCapture, see Using DSmobile Capture (for Windows®)
on page 13.


http://support.brother.com/

Installing the Scanner Driver and Scanning Software

e Click Additional Applications to install any of these applications during setup.
+ Button Manager V2: document scanning and storing (to specified destinations).
* PaperPort™ 12SE or PageManager9: document scanning, editing and management. (Available
software applications can vary depending on your country.)
* Presto! BizCard 6: business card scanning, editing and management.

Additonal Application

DSmobile 620 brother

Addtional Application
j Install Button Manager
j Install PaperPort

j Install Bizcard

(3 2013 Brother Industries, Lkd. All rights reserved. S Back ’rl Exit

NOTE

» For more information on which scanning application will work best for you, see Choosing your scanning
software on page 12.



Installing the Scanner Driver and Scanning Software

For Macintosh users

NOTE
» Make sure that your computer is ON and you are logged on with Administrator rights.

* DO NOT connect the Micro USB Cable yet.

* If your computer does not have a DVD-ROM drive, the supplied DVD-ROM does not contain drivers for
your operating system, or you want to download manuals and utilities, visit your model page at
support.brother.com

€@ insert the DVD-ROM.
9 Double-click on the DVD icon, and then double-click DS-620 (DS-720D).

@ Double-click on Brother DS-620 (DS-720D) and follow the on-screen instructions to install the scanner
driver.

2w

NOTE
When you install the scanner driver, DSmobileCapture (a scanning application) will be installed at the
same time. For more information on using DSmobileCapture, see Using DSmobile Capture (for Macintosh)
on page 24.

6 Click one of these folders to install the application during setup.
+ Presto! PageManager 9: document scanning, editing and management.
* Presto! BizCard 6: business card scanning, editing and management.

NOTE
* Clicking Presto! PageManager or Presto! BizCard will bring you to NewSoft Technology Corporation’s
website. Download the application from this website.

» For more information on which scanning application will work best for you, see Choosing your scanning
software on page 12.


http://support.brother.com/

Acceptable documents

Document Specifications

Standard Paper

Length 1 sided scan
90 mm to 812.8 mm
2 sided scan (DS-720D only)
90 mm to 406.4 mm

Width 55 mm to 215.9 mm

Weight 60 g/m? to 105 g/m?

To scan thinner documents, use the Carrier Sheet (see Loading
the Carrier Sheet on page 10).

Maximum Number of Pages

1 page (1 sheet)

Plastic Cards

(DS-620: non-
embossed cards
only)

Standard Paper Size A4 210 x 297 mm
A5 148 x 210 mm
A6 105 x 148 mm
A7 74 x 105 mm
A8 52 x 74 mm
B5 182 x 257 mm
B6 128 x 182 mm
B7 91 x 128 mm
B8 64 x 91 mm
Legal 215.9 x 355.6 mm
Letter 215.9 % 279.4 mm
Length 40 mm to 86 mm
Width 40 mm to 86 mm
Standard Size (ISO) 85.6 x 54.0 x 0.76 mm
Material Plastic (PET)
Type Plastic card such as a driver’s license or an insurance card
Thickness Less than 0.8 mm

Maximum Number of Pages

1 page (1 sheet)

Receipts

Length 1 sided scan
90 mm to 812.8 mm
2 sided scan (DS-720D only)
90 mm to 406.4 mm
Width 55 mm to 215.9 mm
Thickness More than 0.04 mm

Maximum Number of Pages

1 page (1 sheet)




Document Specifications

Unacceptable documents

B Documents with paper clips or staples

B Documents with wet ink

B Fabrics, metallic sheets, overhead projector sheets
B Glossy or mirrored media

B Embossed plastic cards

B Documents that exceed recommended thicknesses

Documents recommended for use with the Carrier Sheet

Use the supplied Carrier Sheet when you scan the following:

B Documents with a carbon sheet attached on the back

B Documents written in pencil

B Documents narrower than 55 mm wide

B Documents shorter than 90 mm long

B Documents of uneven thickness, such as envelopes

B Documents with large wrinkles or curls

B Bent or damaged documents

B Documents that use tracing paper

B Documents that use coated paper

B Photographs (photographic paper)

B Documents printed on perforated paper

B Documents printed on unusually-shaped paper (not square or rectangular)
B Documents with photos, notes, or stickers affixed to them

B Documents that use carbonless paper

B Documents that use loose-leaf paper or any paper with holes in it
B Photographic negatives

For more information about using the Carrier Sheet when scanning, see Loading the Carrier Sheet on
page 10.

A CAUTION

To avoid cutting yourself, do not slide or scrape your hand or fingers along the edges of the Carrier Sheet.



Document Specifications

IMPORTANT

* Do not place the Carrier Sheet in direct sunlight or in an area subject to high temperatures and high
humidity, or the Carrier Sheet may warp.

* Do not place large or heavy objects on the Carrier Sheet.

» Do not bend or pull the Carrier Sheet. If it becomes damaged, it may not be acceptable for scanning, and
should not be used.



Scan Preparation

Loading a document

IMPORTANT

* Insert only one page into the scanner at a time. Insert the next page only after the first one is completely
scanned. Inserting more than one page at a time may cause your scanner to malfunction.

DO NOT pull on the document while it is feeding.

DO NOT use paper that is curled, wrinkled, folded, ripped, stapled, paper clipped, pasted, or taped.
DO NOT try to scan cardboard or fabric.

NOTE

* Make sure there is enough space behind the paper ejection slot. The scanned document will be ejected
from the rear of the scanner.

» Make sure documents that have ink or correction fluid on them are completely dry.

* Certain types of plastic cards may be scratched when scanned. To prevent damage to the card, we
recommended using the Carrier Sheet. For more information, see Loading the Carrier Sheet on page 10.

0 Set your document @ face up in the feeder slot @ and align the left edge of the page with the left edge
of the feeder slot @.
To scan a plastic card @, set the card top edge first into the feeder slot @ and align the left edge of the
card with the left edge of the feeder slot @.
For DS-720D: When you perform duplex scanning, insert the first page face up into the feeder slot.

9 Slide the document guide @ until it touches the right side of the document.

9 Gently insert the document until you feel its top edge touch the inside of the scanner.

-

Z | —— =% l‘r —
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Scan Preparation

Loading the Carrier Sheet

NOTE
Make sure documents that have ink or correction fluid on them are completely dry.

ﬂ Place the document you want to scan in the left corner of the Carrier Sheet and align the top of the
document with the top left corner of the Carrier Sheet.

9 Set the Carrier Sheet @), document face up, with the black edge first in the feeder slot @ and align the
left edge of the Carrier Sheet with the left edge of the feeder slot €.
For DS-720D: When you perform duplex scanning, insert the first page face up into the feeder slot.

9 Slide the document guide @ against the right side of the Carrier Sheet.

6 Gently insert the Carrier Sheet until you feel its top edge touch the inside of the scanner.

10



Scan Preparation

Important Carrier Sheet tips

B To avoid document jams, do not load the Carrier Sheet upside down. For more information, see Loading
the Carrier Sheet on page 10.

B To avoid document jams, do not put several small documents into the Carrier Sheet at the same time.
Insert only one document into the Carrier Sheet at a time.

B Do not write on the Carrier Sheet, as the writing may be seen in scanned documents. If the Carrier Sheet
becomes dirty, wipe it with a dry cloth.

B Do not leave documents in the Carrier Sheet for extended periods of time, as the printing on the
documents may bleed through onto the Carrier Sheet.

11



Choosing your scanning software

Scanning Applications and Settings

After downloading the scanner drivers, select a scanning software application for saving scanned images to
your computer. Brother has supplied several options for you on the DVD-ROM,; use this table to help
determine which of the included scanning applications will work best for you:

Software

Function

For more information

DSmobileCapture

Document scanning, browsing and filing

For Windows®: See Using
DSmobileCapture (for Windows®) on
page 13.

For Macintosh: See Using
DSmobileCapture (for Macintosh) on
page 24.

Button Manager V2
(Windows® only)

Document scanning and storing (in
specified destinations)

See the software’s user instructions or
Using Button Manager V2 (for Windows
on page 31.

®)

Nuance PaperPort™ 12SE
(Windows® only)

Document scanning, OCR scanning,
editing and management

See the software’s user instructions.

Presto! PageManager 9

Document scanning, OCR scanning,
editing and management

See the software’s user instructions.

Presto! BizCard 6

Business card scanning, editing and
management

See the Presto! BizCard User’s Manual
which will be downloaded onto your
computer when you download the
software.

NOTE

* Clicking Presto! PageManager or Presto! BizCard will bring you to NewSoft Technology Corporation’s
website. Download the application from this website.

12



Scanning Applications and Settings

Using DSmobileCapture (for Windows®)

ﬂ Connect the supplied Micro USB Cable to the Micro USB port on your scanner. Connect the cable to
your computer.

9 Double-click the DSmobileCapture shortcut ‘E on your desktop.

@ The Select Scanner Model dialog box appears. Select TWAIN under Driver Type, select Brother DS-
620 (DS-720D) under Scanner Model, and then click OK.

-
Select Scanner Model

Driver Tvpe:

‘Scanner Madel:
Brother DE=G20

@ DSmobileCapture launches.

rﬁ DSmohileCapture (TWAIN) - DS-620 e (=] E [ |

G e e SIFL

|Ready NUM

13



Scanning Applications and Settings

@ Change the scanning settings, if needed.
For more information on changing settings, see Changing DSmobileCapture scan settings (for
Windows®) on page 16.

@ Insert a document into your scanner.

=0
@ click Scan " . Your scanner starts scanning.

Ready NUM

A thumbnail of the scanned image appears in the DSmobileCapture screen and the scanned image will
be saved in the directory you specified in step 5.
Check the scan result just in case.

14



Scanning Applications and Settings

@ For continuous scanning, insert the next document into the scanner while Waiting for next job

is displayed. When the document is ready, scanning will start automatically.
To stop the continuous scanning, click Cancel on Waiting for next job... screen.

Waiting for next job...
Time remaining : 17 Second

Insert paper to the manual document feeder.

NOTE
» To change the time delay when waiting for the next job, see Paper settings on page 18.

... Screen

* To save multiple documents as one file, choose Multi-page PDF or Multi-page TIFF from the File Format

drop-down list.

15



Scanning Applications and Settings

Changing DSmobileCapture scan settings (for Windows

File settings

®)

(1)

) ®) 4) ()

rﬁ DSr|iobileCapture (TWAIN) - D5

Ready

NUM

(1) | Setup

Change scanner properties.

(2) |File Format

Change the file format.
Select the format you want from the drop-down list.

(3) |Path

Specify the directory where you want to save scanned images.

(4) |FitPage

You can view and size the scanned image.
You cannot use Fit Page when PDF or Multi-page PDF is chosen in File Format.

(5) | Actual Size (100%)

You can view the scanned image in Actual Size (100%).

You cannot use Actual Size (100%) when PDF or Multi-page PDF is chosen in
File Format.

16



Scanning Applications and Settings

Image settings

Click Setup L;’ﬁ‘t: , and then click the Image tab to choose the image type and to set basic scan settings.

NOTE
This image is from the DS-720D.

s Scanner Properties
Image | Paper | Preview I Options I Imprinter | Infon'nationl
Ego,—cl;r ](Brightness: [ D 4 __; 3 ) (3)
- (gonvast e v) (4)
(Hesolution {dpi): IZDD - | [ |) (5)
1) ——L
( ) Qn\rert: [Elack on White '] ) (6)
(2) — (I] Duplex
([ Profiles... ] |Custom v]) (7)
(8) —_— | Drefaults (]9 | | Cancel

(1)

Image Selection Box

Choose the type of document you want to scan.

(2) | Duplex (DS-720D only) Select the Duplex check box to perform Duplex (2 side) scanning.

(3) | Brightness Adjusts the lightness or darkness of an image. The range is from =100 to +100. The
factory default is 0.

(4) |Contrast Adjusts the range between the darkest and the lightest shades in the image. The
range is from -100 to +100. The factory default is 0.

(5) | Resolution Determine the quality of the scanned image. The factory default is 200 dpi.

(6) |Invert Reverse the brightness and the colours in the image.

(7) | Profiles Save or change the scan setting in the Scanner Properties dialog box.

(8) | Defaults Reset values in this and all other Properties tabs to the original factory settings.

17



Scanning Applications and Settings

Paper settings

P

Click Setup LL?; , and then click the Paper tab to define values related to image output.

i Scanner Propertes
| Image | Paper | Preview | Options | Imprirter I Information |
(1 ) (Cmpping: IMomatic 'n f )
(s Naone
@ Portrait Landscape
2 0.00 -
@) » 4)
L 140
rAcIjustment: Left:
Right:
3
( ) Top:
L Bottom: \ /
(5) (Un'rt: Inches
Feeding
(6) (Tlansfer Timeout: 4 I:i F EGSeconds)
(7) — Defaults ‘ 0K l [ Cancel
(1) | Cropping Cropping allows you to capture a portion of the scanned document.

B Automatic

Choose Automatic to allow the software to adjust the cropping window according
to the document size. Use this option for batches of mixed-sized documents.

B Fix for Transfer

Choose Fix for Transfer if you want the ability to define the area or zone to be
imaged. Use for batches of same-sized documents.

18



Scanning Applications and Settings

()

Scan Area

Choose your paper size from the drop-down list or create a custom paper size by
clicking Add in the drop-down list.

If you selected Fix for Transfer in Cropping (1), define the X-Offset and
Y-Offset or specify Width and Length to redefine the scan area. The Display
Area (4) in this screen displays image placement as you change the values.

» X-Offset - the distance from the left edge of the document to the left edge of the
scanned area.

* Y-Offset - the distance from the top edge of the document to the top edge of the
scanned area.

¢ Width - the width of the scanned area.

* Length - the length of the scanned area.

<« 1 Usethese arrows (or your mouse) to move the scan area; you can view

the results in the Display Area of this screen.

@)

Adjustment

Adjustment allows you to add a specific margin at the left, right, top and bottom
of your image. This may help to reduce possible corner clipping on any skewed
images. Select a value from 0 to +5 mm. The Adjustment result will not be shown
in the Display Area.

(4)

Display Area

Displays image placement as you change the values in Scan Area (2).

®)

Unit

Unit allows you to define your preferred measurement system. Select Inches,
Millimeters, or Pixels from the drop-down list.

(6)

Transfer Timeout

Transfer Timeout allows you to set the amount of time (in seconds) the scanner
will wait before starting automatic scanning after the first scan job is completed.
When you have many separate documents that need to be scanned with the same
scan settings, this feature is especially useful. The default time is 30 seconds.

The value ranges from 0 to 60 seconds.

(7)

Defaults

Reset values in this and all other Properties tabs to the original factory settings.

19



Scanning Applications and Settings

Preview settings

Click Setup ”f“ﬁ; , and then click the Preview tab to preview your image before scanning, to make sure the
el

scan area is set correctly.

) Scanner Praperties

| Image | Paper |_I;;e'uiew |Option5 I Imprinter I Inforrnationl

[“IFront Color ( )
["IFrort Gray g ¥+ 2 3 4 5 8 7 B 89
& _.“.I..,.I..,,I...JI....I....I..uluuluul
=
25
23
43
Scan Area: 5_%
150 A4 - 210 297 mm - i
@ Portrait Landscape 1 _5 (1)
&3
HDffset: 0.00 : 9—’5
Y-Offset: 0.00 1 10 —E
Width: 8.26 = 13
Length: 1163 : 12 _';
[ Selected area applies to all modes 0 143 )
(2) —_— Diefaults “ Preview ”: =75 i : ....... ]I (3)
(1) | Preview Window When you click Preview (3), the scanned image will appear in this area. This
preview image lets you define your scan area.
(2) | Defaults Reset values in this and all other Properties tabs to the original factory settings.
(3) | Preview Click to start the preview scan. The scanned image will appear in the Preview
Window (1). Note that the scanned image is only for the preview and will not be
saved.
NOTE

If you chose Automatic cropping, in the Paper tab screen, you cannot preview your scan on this screen.

20




Scanning Applications and Settings

Options settings

Click Setup [:n; , and then click the Options tab to choose additional image processing settings or

calibrate your scanner.

NOTE

This image is from the DS-720D.

,;g Scanner Properties .'
_|_lmage | F‘ap_erl Freview | Options | imprnter | Information | -
( Flip Side Rotation
i [ [
W - !- 4| @ Book #) Farfold
—_—
(- Hotation
(2) — Fotation Degrees : Nene -
.
3) =)
(4) _— Defaults | ok l [ Cancel

(1) | Flip Side Rotation
(DS-720D only)

H Book

Select Book to maintain the same image orientation on the reverse side of the
output page.

® Fanfold

Select Fanfold to rotate the image orientation 180 degrees on the reverse side of
the output page.

(2) | Rotation

Choose the rotation angle from the drop-down list if you want to rotate your
scanned image.

(3) | Calibration

Calibrate the scanner.

For more information, see Calibration using software (for Windows®) on page 37.

(4) | Defaults

Reset values in this and all other Properties tabs to the original factory settings.

21




Scanning Applications and Settings

Imprinter settings

Click Setup c:f”\; , and then click the Imprinter tab to print alphanumeric characters, date, time, document

Sy

count and custom text on your scanned images.

_;; ‘Scanner Properties
i Image I Paper I Preview ! Options rlm_mle;| Inforrnationi
(1)
Content
2)
(3) (D.lstom: )
(4) (Counter: Goo1 FD (Date,-"Time: None - |[E|) (5)
(6) (Custom Fort: |Non'na| VD
Advanced Print Position
(7) (Font Attributes: | Nomal b D Posttion: Middle - |
(8) (String Orientation: |Non'nal vD 0| mm (9)
Sample
oom
[ e— (10)
(1 1) — | Defaults | | 0K | | Cancsl |
(1) | Digital Imprinter Select Digital Imprinter to print the message on the front of your scanned image.
(2) | Print All Select the Print All check box to print your chosen text content, on all pages of your
document. Clear the Print All check box to print the text on the first page only.
(3) |Custom Type the text you want to print.
(4) | Counter Displays the page count for the scan session.
(5) |Date/Time Select a format from the drop-down list if you want to include the date and time in
your text.
(6) |Custom Font Click the drop-down list to select a font for your text.
(7) | Font Attributes Select a font attribute from the drop-down list. Options include Normal, Underline,
Double, or Bold.
(8) | String Orientation Select a text orientation from the drop-down list. Options include Normal, Rotated,
Vertical, Vertical Inversion, 90 Degrees CW' or 90 Degrees CCW?.
(9) | Print Position Select the position of your text from the drop-down list. Options include Top,
Middle, Bottom, or Custom. If you choose Custom, enter the X Offset and Y
Offset values to specify the text position.
(10) | More Click More... to set Size, Density and Transparency for your text.
(11) | Defaults Reset values in this and all other Properties tabs to the original factory settings.

1: Clockwise
2: Counter-clockwise

22




Scanning Applications and Settings

Information

PR

Click Setup Lb?:; , and then click the Information tab to view system and scanner information.

5 Scanner Properties

| Image | Paper I Preview I Options I thprinter|_ Information

Info

intel(F) Core(TM) 5 CFU M 560 @ 2 67GHz

05 Language:
Disk: Drive:
Free Disk Space:

Application Name:
TWAIN Driver Version:
140 Driver Version:
Port Type:

ID / Address:

Optical Resolution:

Scanner Model:
Serial Number:
FAW Version:
Background:

511 MB

Microsoft Windows 7 (Build 7600)

English (United States)

Fixed drive C:\Total:20377MBFree:12026MB
12026 MB

DSmobileCapture 1.6 (1.5)
6.00.0426"13
0.5.2013, 418
Use
Use
00 dpi

D5-620

029
Black Background

Report... |

Diefaults

Cancel

23



Scanning Applications and Settings

Using DSmobileCapture (for Macintosh)

0 Connect the supplied Micro USB Cable to the Micro USB port on your scanner. Connect the cable to
your computer.

9 Double-click the DSmobileCapture shortcut @ on your desktop.

@ DSmobileCapture launches.

800 DS-620
W File Paper dplions Information |
| Front Color
o va Brightness: ':_' 0
Contrast: ) 0
Resolution: {200 "+ | dpi
Invert: | Black on White &
Page Size: | Automatic 2]
Profile: | Custom . + ., =
[ D_efﬂ J X Exii || Eﬂ ] ;s E’revi.e_w i.!'..';ind_"o.\.'\r}b- .

9 Change the scanning settings, if needed.

For more information on changing settings, see Changing DSmobileCapture scan settings (for
Macintosh) on page 25.

@ Insert a document into your scanner.
@ Click Scan in the DSmobileCapture screen.

Your scanner starts scanning. The scanned image will be saved in the directory you specified in step 4.
Check the scan result just in case.
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Changing DSmobileCapture scan settings (for Macintosh)

Image settings

Click the Image tab to choose image type and to set several basic scan settings.

NOTE
This image is from the DS-720D.

800 DS-720D

(1) —

W. File _P.E.lper dptions Information |

9) —l I__D_gf_aull_il [ Exit || Scan

|| Color
] Gray (Brightness: L '__' 0 ) (3)
(Contrast: @ 0 ) (4)
(Resolution: [200 = dpi J (5)
Gnvert: [ Black on White . )— (6)
:_4
(Page Size: I_.Kuioma}i.c $D
(Proﬁle: [ Custom :D gl 5

| Preview Window>> |

(10)

(1)

Image Selection Box

Choose the type of document you want to scan.

(2) | Duplex (DS-720D only) Select the Duplex check box to perform Duplex (2 sided)
scanning.

(3) | Brightness Adjusts the lightness or darkness of an image. The range is from -100 to +100. The
factory default is 0.

(4) |Contrast Adjusts the range between the darkest and the lightest shades in the image. The
range is from -100 to +100. The factory default is 0.

(5) | Resolution Determine the quality of the scanned image. The factory default is 200 dpi.

(6) |Invert Reverse the brightness and the colours in the image.

(7) |Page Size Page Size allows you to capture a portion of the scanned document. Choose your
paper size from the Page Size pop-up list.

(8) | Profiles Save or change the scanning setting in the dialog box of Scanner Properties.

(9) | Default Reset values in this and all other Properties tabs to the original factory settings.
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(10) | Preview Window Click to preview your image before scanning. This preview image helps you define
your scan area.

When you click Preview, scanning for the preview starts and the scanned image
will appear in the Preview Window. Note that the scanned image is only for the
preview and will not be saved.




Scanning Applications and Settings

File settings

Click the File tab to configure the settings related to the file name and the directory where you want to save
the scanned image.

800 DS-620
i_I;nage m f’éper ml';)p.ﬁons Information |
(1) —[ Directory: [ Browse... I]
(2) —— (File Name: [image-%seq ) Digits: (001 |3} 3)
BYYYYMMDD: 20130507 HHHNNSS: 153640
BYYYY: 2013 %BHH: 15
%BYY: 13 HNN: 36
HMM: 05 %SS: 40
HMMM: MAY %Seq: 001
%DD: 07
(4) Sample: Image-001
(When file names are the same: D
(5) — : :
L | Increase sequence number e L
®) (Eile Format: | JPEG (*.jpg) L)
L V| Multi Page Dutput )
Scan to: |. @l File 2] \
7) ——
( ) ™ Show in Finder
\ J
(8) — | Default | | Exit | ; Scan | [i Preview Window>> D— (9)

(1) | Directory Specify the directory where you want to save scanned images.

(2) |File Name Set the rule for the file name of the scanned image.

(3) | Digits Determine the starting number of the sequence number that is included in the file
name.

(4) |Sample Preview the file name that you set.

(5) | When file names are the | Change the file name if the same name already exists in the directory you chose

same in Directory.

(6) |File Format Choose the file format for the scanned image.
When you choose TIFF or PDF, the Multi Page Output option is available.
You can continue to scan the next document after the first scan job is completed.

(7) |Scanto Choose the destination to send the scanned image.

(8) | Default Reset values in this and all other Properties tabs to the original factory settings.

(9) | Preview Window Click to preview your image before scanning. This preview image helps you define
your scan area.
When you click Preview, scanning for the preview starts and the scanned image
will appear in the Preview Window. Note that the scanned image is only for the
preview and will not be saved.
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Paper settings

Click the Paper tab to define values related to image output.

800 DS-620

i_l;nage " File W Oplions Information |

Page Size: | Automatic + | inches =) (2)
(®) Portrait Landscape

X Offset: 0.00 ; Y Offset: 0.00

Width: B.50 . Length: 14.00

(3) S -_Def_aui_t;E Ell _ | : “S.!gan | Eﬂview Window>> )7(4)

(1)

Page Size

Page Size allows you to capture a portion of the scanned document.

Choose your paper size from the Page Size pop-up list, define the X Offset and
Y Offset values or specify Width and Length to define your scanned area. Click
Preview Window (4) to preview the image placement as you change the values.

« X Offset - the distance from the left edge of the document to the left edge of the
scanned area.

» Y Offset - the distance from the top edge of the document to the top edge of the
scanned area.

* Width - the width of the scanned area.
* Length - the length of the scanned area.

()

Unit

Unit allows you to define your preferred measurement system. Select Inches,
Millimeters, or Pixels from the pop-up list.

@)

Default

Reset values in this and all other Properties tabs to the original factory settings.

(4)

Preview Window

Click to preview your image before scanning. This preview image helps you define
your scan area.

When you click Preview, scanning for the preview starts and the scanned image
will appear in the Preview Window. Note that the scanned image is only for the
preview and will not be saved.

28



Scanning Applications and Settings

Options settings

Click the Options tab to set some additional image processing settings or calibrate your scanner.

(2)
@)

—

®00 DS-620
i_l;nage | File | Paper [F 3 information |
(Rotation Degrees: [ None : D
Calibration ')
[ Exit | : Scan | [ Preview Windows> ]—(5)

(1)

Rotation Degrees

Choose the rotation angle from the pop-up list if you want to rotate your scanned
image.

(2) | Mirror Select the Mirror check box to reverse your image.
(3) | Calibration Calibrate the scanner.

For more information, see Calibration using software (for Macintosh) on page 40.
(4) | Default Reset values in this and all other Properties tabs to the original factory settings.
(5) | Preview Window Click to preview your image before scanning. This preview image helps you define

your scan area.

When you click Preview, scanning for the preview starts and the scanned image
will appear in the Preview Window. Note that the scanned image is only for the
preview and will not be saved.
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Information

Click the Information tab to view system and scanner information.

800 DS-620
| Image | File | Paper | Options _ ——
Scanner Model D5-620
‘Serial Number CN11335Y7Z200034
Version 3.00.0503'13
|/ O Driver Version 2013.4.25
| F/W Version 0.29
(Language: | English = |)——(1 )

DSmobileCapture

Copyright © 2013 Brother Industries, Ltd. All Rights Reserved.

‘ (1) ‘ Language Choose the language you want to display from the pop-up list.
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Using Button Manager V2 (for Windows®)

NOTE
» For more detailed instructions, see the Button Manager V2 User’s Guide from the application’s help menu.

* To see the help menu, right-click the Button Manager V2 icon on the system tray, and then click

Help.
Use either one of these two methods to launch Button Manager V2.

To display the shortcut icon and launch Button Manager V2 from your system tray

a Connect the Micro USB Cable to the Micro USB port on your scanner. Connect the Micro USB Cable to
a USB port on your computer.

9 Click the Button Manager V2 icon on the system tray at the bottom right corner of your computer
screen.

@ Button Manager V2 launches.

= Brother DS-620
.- ‘a‘ Scan

| (o ff‘ Scan To App

| rﬁ'l E-Mail

vk Printer

—
|

.II
| '__‘5__ Shared Folder

& =
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Scanning Applications and Settings

To launch Button Manager V2 from the Windows® Start button

o Sy
0 Click Start @ > All Programs > Brother DS-620 (DS-720D) Scanner > Button Manager > Button

Manager V2f.h_

9 When the Select Scanner Model dialog box appears, select your scanner model from the list, and then
click OK.

e Button Manager V2 launches.

= Brother DS-620 [

i [ s

L a:,__r'_‘.i Scan To App

(Il @IJ E-Mail

| Printer
!

—

Ly
| — Shared Folder

& =
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Scanning methods

There are two ways to scan using Button Manager V2. If necessary, check or change scan settings before
scanning.

To scan using the scan button on the Button Manager V2 Button Panel

Insert a document into your scanner.

Launch Button Manager V2.

If necessary, right-click the desired scan button in the Button Manager V2 Button Panel to change scan

settings.
For more information, see the Button Manager V2 User’s Guide.

Click the scan button you want to use in the Button Manager V2 Button Panel to start scanning.

To scan using the Start button on your scanner

Insert a document into your scanner.

Launch Button Manager V2.
If necessary, right-click the desired scan button in the Button Manager V2 Button Panel to change scan

settings.
For more information, see the Button Manager V2 User’s Guide.

Select the check box to the left of the scan button you want to use.

Press the Start button on your scanner to start scanning.
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Scan buttons in the Button Manager V2 Button Panel (for
Windows®)

Scan to an image

Use this option to open the scanned image in a specific application. Note that the application must already
be open and running on your computer.

To change scan settings, right-click the Scan ‘@| Scan button (see the Button Manager V2
User’s Guide). —

6 Insert a document into your scanner.
9 Launch Button Manager V2.

0 Click Scan ‘ﬁ| s

When scanning is complete, the scanned image will be inserted to your open and running application.
Check the scan result just in case.

NOTE

+ If no application launches or the application is minimized, the scanned image will be saved in a predefined
folder (for more information about changing the folder path, see the Button Manager V2 User’s Guide).

+ If two or more applications are open, the scanned image will appear in the active application.

Scan to an application

Use this option to open the scanned image in an application that you choose from a list.

To change scan settings, right-click the Scan to App & , Scan To App button.

0 Insert a document into your scanner.
9 Launch Button Manager V2.
9 Click Scan to App /i , Scan To App to start scanning.
When scanning is complete, the scanned image will be opened in an application you chose from the

displayed list.
Check the scan result just in case.
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Scan to an email

Use this option to attach the scanned image to an email.

To change scan settings or email software, right-click the E-mail |L§/| E-Mail button.

ﬂ Insert a document into your scanner.
9 Launch Button Manager V2.
0 Click E-mail :@l E-Mail to start scanning.
When scanning is complete, your email software launches and the scanned image will be attached to a

blank email.
Check the scan result just in case.

Scan to a printer

Use this option to print the scanned image from your default printer.
To change scan settings or destination printer, right-click the Printer Q Brinter button.

0 Insert a document into your scanner.
9 Launch Button Manager V2.

@ Click Printer d;"] Printer to start scanning.

When scanning is complete, the scanned image will be printed from your default printer.
Check the scan result just in case.

Scan to shared folder

Use this option to save the scanned image in a shared folder on your network.

e ———1

To change scan settings, right-click the Shared Folder | | shared Faider button.

a Insert a document into your scanner.
9 Launch Button Manager V2.
@ Click Shared Folder || shared Folder to start scanning.

When scanning is complete, the scanned image will be sent directly to the shared folder.
Check the scan result just in case.
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Scan to a FTP server

Use this option to save the scanned image in a folder on your FTP server.

To change scan settings, right-click the FTP &‘3 TP button.

ﬂ Insert a document into your scanner.

9 Launch Button Manager V2.
0 Click FTP r@‘\ﬂ' ETP to start scanning.

When scanning is complete, the scanned image will be sent directly to the folder on your FTP server.
Check the scan result just in case.
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Scanner Calibration

Calibrate your scanner only if the scanned images start to look fuzzy, the colour looks abnormal (darker than
normal), after 8,000 scans, or if the scanner has been stored without being used for a long time.

You will need the Calibration Sheet that came with your scanner, to successfully perform calibration.

Calibration using software (for Windows®)
0 Double-click the DSmobileCapture shortcut ﬁ on your desktop.

9 The Select Scanner Model dialog box appears. Select TWAIN under Driver Type, select
Brother DS-620 (DS-720D) under Scanner Model, and then click OK.

9 DSmobileCapture launches.

|Ready NUM
b =  ——————
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Scanner Calibration

@ Click the Options tab.

@ Click Calibration to start calibrating the scanner.

-
g1 Scanner Properties

| Image;l Paper I Presvigm | Optionz | Imprirter I Info_rmatio_ni

Flip Side Rotation

@ Book

Rotation

Fotation Degrees :

Fantald

Mone -

"4

Galibration..

QK

J {

Gancel

]

0 A message appears, prompting you to insert the Calibration Sheet.

P !.3 Insert the calibration sheet into the scanner.
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Scanner Calibration

@ Hold the edges of the Calibration Sheet and insert it into the feeder slot as shown below.
Click Yes.

CALIBRATION SHEET |

NOTE
Hold only the edges of the Calibration Sheet and be careful not to touch the white or black area. Leaving
marks or fingerprints on this sheet can cause errors in calibration.

@ Scanning starts automatically.

@ After the Calibration Sheet is scanned, a Calibration was successful message appears on your
screen, indicating that calibration is finished. Click OK to end calibration, and then click OK to close the
Options screen.

P N
Calibration [ﬂ

Calibration was successful.

Ol

NOTE
If a Calibration failed message appears on your screen, remove the Micro USB Cable from your
computer. Reconnect the Micro USB Cable to the computer and perform the calibration again. If calibration
fails again, check the scanner’s print head to ensure it is clean.
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Scanner Calibration

Calibration using software (for Macintosh)

0 Double-click the DSmobileCapture shortcut @ on your desktop.
@ DSmobileCapture launches.
@ Click the Options tab.

@ Click Calibration to start calibrating the scanner.

808 DS-620
I _Image | .File: | Paper | Information |
Rotation Degrees: | None il
{1 Mirror I
ﬁ Calibration U
| Default | [ Exit .:II Scan N I Preview Winq_E:_vtr}} R

6 A message appears, prompting you to insert the Calibration Sheet.

Insert the calibration sheet into the
scanner.

_Cancel | [ ok ]
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Scanner Calibration

@ Hold the edges of the Calibration Sheet and insert it into the feeder slot as shown below.
Click OK.

CALIBRATION SHEET |

NOTE
Hold only the edges of the Calibration Sheet and be careful not to touch the white or black area. Leaving
marks or fingerprints on this sheet can cause errors in calibration.

0 Scanning starts automatically.

@ After the Calibration Sheet is scanned, a Calibration was successful message appears on your
screen, indicating that calibration finished successfully. Click OK to end calibration.

Calibration was successful.

ok |

NOTE

If a Calibration failed message appears on your screen, remove the Micro USB Cable from your
computer. Reconnect the Micro USB Cable to the computer and perform the calibration again. If calibration
fails again, check the scanner’s print head to ensure it is clean.
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Scanner Maintenance

IMPORTANT

Do not use any solvents or corrosive liquid, such as alcohol, kerosene, etc., to clean any part of the
scanner, or the plastic may be permanently damaged.

Cleaning the outside of your scanner

To prevent dust accumulation, we recommend cleaning the exterior of your scanner periodically.
ﬂ Remove the Micro USB Cable from both your scanner and your computer.

9 Wipe the outside of the scanner with a dry, soft, lint-free cloth.
If necessary, wipe the exterior with a cloth lightly dampened with water or diluted detergent, and finish
with a dry cloth.

@ Reconnect the Micro USB Cable to your scanner and your computer.

Cleaning the inside of your scanner

To maintain the scanned image quality, clean the interior of your scanner periodically. If vertical lines or
stripes appear on scanned images, this indicates that it is time to clean your scanner.

0 Remove the Micro USB Cable from both your scanner and your computer.

9 Open the scanner’s top cover.
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Scanner Maintenance

e Gently wipe the scanning glass strip and feed rollers with the supplied cleaning cloth.

@ Close the top cover.

@ Reconnect the Micro USB Cable to your scanner and your computer.
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IMPORTANT

Troubleshooting

For technical help, you must contact the Customer Service center in the country where you bought the
scanner. For more information, see For customer service on page 55. Calls must be made from within

that country.

If you think there is a problem with your scanner, check the chart below and follow the suggestions.

Most problems can be easily resolved by yourself. If you need additional help, go to the Brother Solutions
Center at support.brother.com for more FAQs and troubleshooting tips.

Using non-Brother supplies may affect scan quality, hardware performance and product reliability.

Error and maintenance messages

Error message

Cause

Action

Driver busy

The scanning application in use
crashed, or the scanner driver is
locked with administrator rights.

Remove the Micro USB Cable from
your computer. Reconnect the Micro
USB Cable to the computer, and
launch the application again.

A document is jammed. Please open
the top cover and remove the
jammed paper by pulling it forward,
then try again.

A document is jammed.

Open the top cover and remove the
document by pulling it forward, then
close the top cover.

The cover of the manual document
feeder is open.

Your scanner’s top cover is open
when scanning starts.

Close the top cover and start
scanning again.

No paper in the manual document
feeder

No document is set in the feeder slot.

Place your document in the feeder
slot and start scanning again.

Cannot find the scanner.

Your scanner is not connected to
your computer.

Confirm that the Micro USB Cable
connecting the scanner to the
computer is properly connected.

Operation system return error

Your Operating System cannot
recognize your scanner.

B Confirm that the Micro USB Cable
connecting the scanner to the
computer is properly connected.

B Restart the computer.
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Troubleshooting

Error message

Cause

Action

Calibration failed. Please reboot the
machine.

An error caused the calibration to fail.
Forexample, the Calibration Sheetis
not inserted in the correct direction.

B Remove the Micro USB Cable
from your computer. Reconnect
the Micro USB Cable to the

computer, and perform the
calibration again.

B Insert the Calibration Sheet in the
correct direction.

« For Windows®: to perform the
calibration using software, see
Calibration using software (for
Windows®) on page 37.

» For Macintosh: to perform the
calibration using software, see
Calibration using software (for
Macintosh) on page 40.

Troubleshooting

Scanning difficulties

Difficulty

Cause

Suggestions

My scanner does not
turn on.

The supplied Micro USB Cable is not
connected securely.

Make sure the Micro USB Cable is securely
connected to your scanner and computer.

My computer does not
recognize the scanner
when it is connected
via the Micro USB
Cable.

Causes may vary.

Make sure the Micro USB Cable is securely
connected to your scanner and computer. Remove
the Micro USB Cable and reconnect the Micro USB
Cable to your scanner and computer.

My scanned images
have black lines
running through them,
blank spaces, or are of
overall bad quality.

This problem occurs if the scanner is
not calibrated correctly or if a foreign
object, such as a paper clip or ripped
paper, is stuck in the scanner.

1. Check the document feeder slot and make sure
that the slot is clear. If foreign objects are found,
remove them from your scanner.

2. Calibrate your scanner (see Scanner Calibration
on page 37).

If scan quality is not improved after you calibrate

your scanner:

1. Clean the scanner (see Scanner Maintenance on
page 42).

2. Calibrate your scanner again.

45




Troubleshooting

Difficulty

Cause

Suggestions

My document did not
scan correctly.

The Document Guides are not adjusted
to fit the width of the document.

Adjust the Document Guide to fit the width of the
document.

The settings are not suitable for your
document. For example, a A4
document was fed when A5 was
selected as document size.

Make sure the document size settings are suitable
for your document.

For Windows®: see Paper settings on page 18.

For Macintosh: see Paper settings on page 28.

The scan speed is too
slow.

The resolution is not suitable for your
document.

Decrease the scanner resolution.

®

For Windows™: see Image settings on page 17.

For Macintosh: see Image settings on page 25.

My scanner is
connected but it will
not feed my document
or do anything else.

Your document is not set correctly.

Insert your document until you feel the top edge of
the document touch the inside of your scanner.

Your document is too thin or too thick.

Check that your document is acceptable (see
Document Specifications on page 6).

If your document is not the problem:

1. Confirm that the Micro USB Cable connecting
your scanner to your computer is securely
connected.

2. Re-install the scanner driver from the DVD-ROM.

The scanner’s top cover is open.

Close the top cover and start scanning again.

The document is
jammed.

Causes may vary.

Open the scanner’s top cover and gently pull out
the document. Make sure that no piece of paper
remains inside the scanner.

Your document is not acceptable for the
machine (for example, if the paper is
too long).

B Make sure your document is acceptable for the
machine (see Document Specifications on
page 6).

B Use the supplied Carrier Sheet (see Loading the
Carrier Sheet on page 10).

My scanner gets
warm.

It is normal for your scanner to emit a
small amount of heat after prolonged
use.

If there is a strange smell coming from the scanner
or the scanner feels a little bit hot to the touch,
immediately remove the Micro USB Cable from
your scanner and computer.
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Difficulty

Cause

Suggestions

The scan quality is
poor.

Paper dust has accumulated inside
your scanner.

Clean your scanner (see Scanner Maintenance on
page 42).

Calibration needs to be performed.

Perform the calibration.

+ For Windows®: to perform the calibration using
software, see Calibration using software (for
Windows®) on page 37.

» For Macintosh: to perform the calibration using
software, see Calibration using software (for
Macintosh) on page 40.

The scanner resolution is too low.

Increase the scanner resolution.

®

For Windows™: see Image settings on page 17.

For Macintosh: see Image settings on page 25.

Colours in the
scanned image are
dark.

The settings are not appropriate for the
type of document being scanned.

Adjust the scanning settings.
For Windows®: see Image settings on page 17.
For Macintosh: see Image settings on page 25.

Calibration needs to be performed.

Perform the calibration.

+ For Windows®: to perform the calibration using
software, see Calibration using software (for
Windows®) on page 37.

» For Macintosh: to perform the calibration using
software, see Calibration using software (for
Macintosh) on page 40.

OCR feature does not
work.

The scanner resolution is too low.

Increase the scanner resolution.

Use PaperPort™ 12SE or Presto! PageManager
9 to increase the resolution.

Nuance PaperPort™ 12SE has not
been installed on your computer.

Make sure you have installed Nuance PaperPort™
12SE from the supplied DVD-ROM.

Presto! PageManager has not been
installed on your computer.

Make sure you have installed Presto!
PageManager from the supplied DVD-ROM.

The scanned image is
skewed (slanted).

The scanner’s Document Guide are not
adjusted to fit the width of the
document.

Adjust the Document Guide to fit the width of the
document.

White vertical lines or
white stripes appear

The scanner is in direct sunlight.

* Move the scanner indoors, or out of direct
sunlight.

on the scanned image.

A light source is near the scanner.

» Move the scanner away from the light source.
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Difficulty

Cause

Suggestions

Bleed-through is seen
in the scanned image.

Your document is too thin.

Check that your document is acceptable (see
Document Specifications on page 6).

The contrast setting is improper.

Increase the contrast level.

®

For Windows™: see Image settings on page 17.

For Macintosh: see Image settings on page 25.

(DS-720D only)

Duplex scanning
cannot be performed.

The duplex scanning settings are not
configured in DSmobileCapture.

Select the Duplex check box of the Image tab in
DSmobileCapture.

Software difficulties

Difficulty

Cause

Suggestions

When | press Scan in
my scanning software,
an error message
appears: Please
install scanner or
The scan was
aborted because the
scanner is not
powered on or not
connected properly.

This error message appears if your
scanner isn’t recognized by your
computer.

1. Make sure your scanner is connected properly.

2. Confirm that the Micro USB Cable is working and
that it is not frayed or damaged in any way.

If the error still appears after verifying that the Micro
USB Cable is connected properly, reinstall the
scanner driver from the DVD-ROM.

| cannot install the
scanner drivers.
(Windows®)

You may not have been given
administrator privileges.

Log into Windows® with administrator rights.

| cannot install the
scanner drivers.
(Macintosh)

You may not have been given
administrator privileges.

From Apple menu, select System Preferences >
System > Users & Groups. The left pane of the
window will list the current accounts, one of which
should be your name with the word “Admin”
underneath. If this is not the case, contact your
system administrator.

The file size is too
large.

The size of the file will depend upon
many factors. The physical size of the
document and the amount of text /
graphics on each page are factors that
will affect the resulting file size. These
factors cannot be changed.

To produce the smallest scan file for a given
document, use the lowest resolution and Black and
White mode, and scan the smallest area possible.
Using the opposite settings (scanned in the highest
resolution, in the Colour mode, and scanning the
largest area possible) will produce the largest-sized
file.

For Windows®: see Changing DSmobileCapture
scan settings (for Windows®) on page 16.

For Macintosh: see Changing DSmobileCapture
scan settings (for Macintosh) on page 25.
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Troubleshooting

Other difficulties

Difficulty

Cause

Suggestions

| do not have or lost

the Calibration Sheet.

Causes may vary.

The special glossy calibration sheet that came with
your scanner will give you the best calibration
results. To order a new Calibration Sheet, please
contact Brother.

| want to use a USB
hub.

Causes may vary.

A USB hub may not be able to supply enough
power to the scanner.
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Specifications

NOTE

Appendix A

This chapter provides a summary of the scanner’s specifications. For additional specifications, go to your
scanner’s product page at www.brother.com and click the Specifications tab.

General

DS-620 DS-720D

Power Source

USB bus-power 5V DC

Power consumption Scanning 2.5 W 500 mA or less
Ready 1.0 W 200 mA or less
Dimensions Width 290.5 mm
Height 36.7 mm 40.7 mm
Depth 52.5 mm 66.9 mm
Weight Approx. 400 g Approx. 500 g
Temperature Operating 5Cto35-C
Humidity Operating 15 to 85%
Storage 10 to 90%
Document Size Single Sheet Width 55 mm to 215.9 mm
Length 1 side scan
90 mm to 812.8 mm

- 2 side scan
(DS-720D only)
90 mm to 406.4 mm
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Appendix A

Scanner
DS-620 | DS-720D
Colour / Black Yes/Yes
Duplex Scan No ‘ Yes
TWAIN Compliant | Windows® Windows® XP 1/ Windows Vista® / Windows® 7 / Windows® 8 /
Windows® 8.1/ Windows® 10

Macintosh Mac OS X 10.6.x, 10.7.x, 10.8.x, 10.9.x, 10.10.x, 10.11.x 2
Colour Depth Input 48 bit colour processing

Output 24 bit colour processing
Resolution Optical Up to 600 x 600 dpi

Interpolated 1200 dpi
Scanning Width Up to 216 mm
Greyscale Input 16 bit

Output 8 bit

Scanning Max. Speed

Mono 8.0 ppm (7.5 seconds (Letter) up to 300 dpi)
7.5 ppm (8 seconds (A4) up to 300 dpi)
4.3 ppm (14.1 seconds (Letter) above 400 dpi)
4 ppm (15 seconds (A4) above 400 dpi)
Colour 8.0 ppm (7.5 seconds (Letter) up to 300 dpi)
7.5 ppm (8 seconds (A4) up to 300 dpi)
4.3 ppm (14.1 seconds (Letter) above 400 dpi)
4 ppm (15 seconds (A4) above 400 dpi)

Duplex Scanning Max. Speed

- Mono 5.3 ppm (11.3 seconds
(Letter) up to 300 dpi)

5 ppm (12 seconds (A4) up
to 300 dpi)

3 ppm (19.8 seconds
(Letter) above 400 dpi)

2.9 ppm (21 seconds (A4)
above 400 dpi)

Color 5.3 ppm (11.3 seconds
(Letter) up to 300 dpi)

5 ppm (12 seconds (A4) up
to 300 dpi)

3 ppm (19.8 seconds
(Letter) above 400 dpi)

2.9 ppm (21 seconds (A4)
above 400 dpi)

1

2

Windows® XP in this User's Guide includes Windows® XP Home Edition and Windows® XP Professional.

For the latest driver updates for the version of Mac OS X you are using, visit us at support.brother.com
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Interfaces

usSB

Hi-Speed USB 2.0 12
Use a USB 2.0 cable (Type A/ B) that is no more than 1.2 metres long.

1

2

Third party USB ports are not supported.

Computer requirements

Your scanner has a Hi-Speed USB 2.0 interface. The scanner can also be connected to a computer that has a USB 1.1 interface.

SUPPORTED OPERATING SYSTEMS AND SOFTWARE FUNCTIONS

Hard Disk Space to

Computer Platform & Processor Minimum Recommended install Supsgrted
Operating System Version Minimum Speed RAM RAM For For Interface
Drivers | Applications
Windows® |Windows® XP  |Intel® Core™ 2 Duo 1GB 2 GB 80MB | 1.2GB USB
Operating |Home or equivalent
System | windows® XP
Professional
Windows® XP  |64-bit (Intel® 64 or 1GB 2 GB
Professional x64 | AMD64) supported
Edition CPU
Windows Vista® |Intel® Core™ 2 Duo 1GB 2 GB 80 MB 1.2 GB
or equivalent 64-bit
(Intel® 64 or AMD64)
supported CPU
Windows® 7 Intel® Core™ 2 Duo |1 GB (32-bit) | 2 GB (32-bit) | 80 MB 1.2GB
or equivalent 64-bit |, ~p5 w4 ity | 4 GB (64-bit
(Intel®64 or AMD64) (64-bit (64-bit)
supported CPU
Windows®8  |[Intel® Core™ i3 or |1 GB (32-bit)| 2 GB (32-bit) | OMB | 1.2 GB
equivalent 64-bit |, g (g4.pit)| 4 GB (64-bit
(Intel®64 or AMD64) (64-bit (64-bit)
supported CPU
Windows® 8.1  |Intel® Core™ i3or |1 GB (32-bit)| 2 GB (32-bit) | 80 MB | 1.2 GB
equivalent 64-bit 15 g (54.pit) | 4 GB (64-bit
(Intel® 64 or AMD64) (64-bit (64-bit)
supported CPU
Windows® 10 |Intel® Core™ i3 or |1 GB (32-bit)| 2 GB (32-bit) | 80MB | 1.2GB
equivalent 64-bit 2 GB (64-bit)| 4 GB (64-bit
(Intel® 64 or AMD64) | > CB (64-bt) | 4 GB (64-bit)
supported CPU
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Macintosh
Operating
System

Mac OS X 10.6.x |Intel® Processor 1GB 2GB
Mac OS X 10.7.x|Intel® Processor 1GB 2 GB
Mac OS X 10.8.x|Intel® Processor 2 GB 4 GB
Mac OS X 10.9.x|Intel® Processor 2 GB 4 GB
Mac OS X 10.10.x| Intel® Processor 2GB 4 GB
Mac OS X 10.11.x|Intel® Processor 2 GB 4 GB

80 MB

400 MB

uUSB

For the latest driver updates, visit support.brother.com

All trademarks, brand and product names are property of their respective companies.
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Contacting Brother

IMPORTANT
For technical help, contact the Customer Service center in the country where you bought the scanner. For
more information, see For customer service on page 55. Calls must be made from within that country.

Register your product

By registering your product with Brother International Corporation, you will be recorded as the original owner
of the product. Your registration with Brother:

B may serve as confirmation of the purchase date of your product should you lose your receipt
B may support an insurance claim by you in the event of product loss covered by insurance
® will help us notify you of enhancements to your product and special offers

Complete and fax the Brother Warranty Registration And Test Sheet or, for your convenience and most
efficient way to register your new product, register online at

www.brother.com/registration

Frequently asked questions (FAQs)

The Brother Solutions Center is our one-stop resource for all your Brother machine needs. You can download
the latest software documents and utilities, read FAQs and troubleshooting tips, and learn how to get the most
from your Brother product.

support.brother.com

You can check the Brother Solutions Center for Brother driver updates.

To keep your machine performance up to date, check the Brother Solutions Center for the latest firmware
upgrade.
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Appendix B

For customer service

For Australia Only:

Support - For technical support of your Brother Product other than what you can resolve through the User's
Guide, please visit our Web Site or Solutions Web Site (see below) to find an answer to
FAQs/Troubleshooting, locating Drivers & Software.

Alternatively, please contact the Product Support Centre for any customer care/technical support enquiry.

To contact Brother International (Aust) Pty Ltd for support on a Brother product please see the details
listed below:

Product Support Centre: Australia
Brother International (Aust) Pty Ltd
Phone: 02 8875 6000
Fax: 02 9870 7223
Solutions Site: support.brother.com
Web Site: www.brother.com.au
E-mail: To submit an e-mail enquiry, visit www.brother.com.au go to

Service and Support area and follow the prompts.

Our Technical Support Consultants are available 5 days a week by phone during the hours of 8.30am to
5.00pm (EST/EDST) Monday to Friday.

For New Zealand Only:

To contact Brother International (NZ) Limited for support with a Brother product please use the following
methods.

Phone:

Premium End User Assistance 0900 552 152

Auto Attendant Self Help 0800 652 152

Brother Recycle Assistance 0800 632 467

Fax Assistance 0800 837 822

Email Assistance Please visit www.brother.co.nz and submit a helpdesk enquiry from
Web Assistance Online Help

Please visit www.brother.co.nz under Online Help for Frequently
Asked Questions, Driver downloads, Warranty information and
Service Centres

Our Technical Support Consultants are available 7 days a week by phone during the hours of 8.30am to 5pm
Monday to Friday and 9am to 5pm Saturday and Sunday. Outside of these hours you can find assistance
from our Auto Attendant Self Help and our Website www.brother.co.nz under Online Help.
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Appendix B

Technical support (For PageManager® and BizCard®)

Taiwan

Tel:

Fax:

E-mail:

All other locations
E-mail:

+886-2-8751-8200
+886-2-8751-2880

contactus@newsoft.com.tw

tech@newsoft.eu.com
(English only)
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